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Congratulations on your  
choice of Bewapass/Entro! 

This manual is intended for the person responsible for the Bewapass-/Entro access 
control system. Start reading the manual when the installer has fitted the card 
readers and the segment controllers, wired the system and allocated addresses to 
all doors in the system. When this is done it is time to programme in the information 
needed for the system to function the way you desire. The manual describes how 
to do this.  

If you intend to also use Reservation function – we have chosen to describe this in 
a separate chapter starting on page 52. Reservation uses a network based Entro 
system (which maybe not installed in all applications).  

Instructions on managing and running the programming, such as registering and 
deleting persons from the system, are found in the system’s built-in Help function. 
How to use the Help function is described in the Using Help section below. 

You should be familiar with Windows 
Bewapass/Entro is designed to make programming of the information as easy as 
possible. It is however an advantage if you are familiar with the Windows 
environment. If you have no previous experience of Windows, we recommend that 
you take a basic course. 

Using Help 
Bewapass/Entro has a built-in Help function. Using Help you can display 
instructions on your screen about the task you are currently performing.  

To open the Help function, click the Help button, or press F1 on the keyboard. 

By clicking the right mouse button as you point to an object (a field, tab or similar) 
you can display a descriptive text about this particular object. Clicking the question 
mark button and then pointing to the object you need help on obtain the same 
effect. 
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This is how the system works 
Bewapass/Entro is an access control system. It is designed for use in both small 
companies and large ones, wherever there is a need to control which people 
should have access to the different doors and departments in the premises.  

Next to the doors, card readers with keypads (optional) are installed. The card 
readers are connected to segment controllers, which, in their turn are programmed 
from a PC. 

If needed, Bewapass/Entro can control up to 1000 access control systems installed 
in different buildings. The systems may be connected directly to the PC, using local 
network or be connected via a modem. 

Bewapass/Entro consists of the following equipment: 
• The Bewapass/Entro software. The software runs on a PC with Windows 

98/2000/XP/NT4 or later. It controls up to 512 doors and can manage 
information about 12 000 people. 
In Bewapass/Entro is an integrated software module for reservation 
functions, like time booking for sports arenas etc. 

• SR32i Segment controllers. Up to 16 segment controllers can be 
connected to the PC in a loop. Each segment controller is capable of 
controlling 2, 4, 8, 16 or 32 doors. The information you programme in the 
PC is stored in all segment controllers. This brings the advantage of being 
able to use the PC for other purposes or shut it off when you are not 
programming or controlling the system. 

• Door controllers with remote readers. The door controllers are 
connected to the segment controllers. A door controller controls one door, 
with one reader. If BC43 readers are used, In/Out readers may be used on 
the door. This combination is designed for outside doors or other doors with 
higher requirements on function and security, e.g. alarm by-pass. 

• Other reader types. Other reader types, e.g. proximity readers and hands-
free readers, may also be connected to the door controllers. 

• Door terminals DT05 or DT05Prox. Simple card readers connected 
directly to a segment controller. They are installed indoors, next to doors 
with lower requirements on function and security. 
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Important concepts 
To be able to programme the system you have to be familiar with the following 
concepts: 

• Security levels 
• Time schedules and time zones 
• Access groups 
• Access registration 
• Zones 

If you intend to use the Reservation system – see section Important concepts – 
Reservation on page 54.     

Security levels 
The security level determines what action is needed to open a door. The following 
security levels exist: 

• Door unlocked. The door is unlocked. 
• Group code. The door can be opened using a four-digit code, shared by a 

group of people. 
• Card only. To open the door, a personal access card should be swiped 

through the card reader. If the card is lost or stolen it is easy to cancel the 
card. 

• Card + PIN. The door is opened when the access card is swiped and a 
personal code belonging to this particular card has been entered.  

• Toggle – Group code. Similar to Group code above. When the code is 
entered the first time, the door is opened and remains unlocked until the 
code is entered the second time. 

• Toggle – Card. When the card is swiped the first time, the door is opened 
and remains unlocked until the card is swiped the second time. 

• Toggle – Card + PIN. When the card is used and the code is entered the 
first time, the door is opened and remains unlocked until the card is used 
and the code is entered the second time. 

• Accompanied Access. Two people, each swiping their cards and entering 
their codes within 15 seconds, are needed to open the door. 

• Closed door. The door cannot be opened by the card reader, but only from 
an exit request button from the inside. 

• Locked door. The door is completely disconnected from the system, which 
means that not even exit request operates. 

• Personal code without card. Bewapass/Entro can be set so that users 
may choose a PIN code instead of a card. This will disable the Group code 
operation. 

Using the security levels, you can determine the suitable type of protection for your 
premises. During the day, when there are people in the premises, Group code or 
Card only may be sufficient. During the night, the Card + code security level is 
perhaps more suitable. 
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Time schedules and time zones 
The purpose of creating time schedules is to give different people access to a 
door at different hours, and to determine security levels for a door at different 
hours. 

In an average-sized company, the staffs probably have similar working hours. If 
this is the case, you may create a time schedule for these hours called, for 
example, Office hours. A time schedule covers 24 hours and can be divided into 
time zones. 

00.00-07.59 17.00-23.5908.00-11.59 13.00-16.5912.00-12.59

Other time Working hours Lunch Working hours Other time

Example

 

Time zone 1: Working hours Mon.–Fri. 8.00–11.59, 13.00–16.59 
Time zone 2: Lunch Mon.–Fri 12.00–12.59 
Other time: All time not in Time 1 & Time 2, including Holidays 

Note! A time zone is valid from and including the first second in the first minute 
up to and including the last second in the last minute. 

The purpose of dividing the time schedule into time zones is to be able to provide 
each door with a specific security level for each time zone. If you divide the time 
schedule into the time zones Working hours, Lunch and Other time, you can 
give the door a security level for each of these time zones. During office hours, 
when there are people in the building, perhaps Group code is suitable. During 
lunch, you can set the security level to Card only.  

During the remaining time, i.e. nights and weekends, you could raise the security 
level to Card + PIN. If you only need two different security levels, it is sufficient to 
divide the time schedule (the 24 hours) into two time zones, i.e. Time zone 1 and 
Other time. 

During programming, you will be asked to enter security levels for one door at a 
time. If a door leads to a department requiring a high security level 24 hours a day, 
set the security level to Card + PIN for all three time zones. 

Card + PIN Card + PIN Group code  Group CodeCard

Other time Working hours Lunch Working hours Other time

Example

Card + PIN Card + PINCard + PIN Card + PINCard +
PIN

Other time Working hours Lunch Working hours Other time

Door: Entrance, time schedule: Office hours

Door: Research dept, time schedule: Office hours
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If the company has workshop personnel with other working hours, you may create 
a second time schedule to determine the permissions for doors leading to the 
workshop premises. 

You can programme up to 160 different time schedules with three time zones per 
time schedule. Other time is always one of the time zones. 

Access groups 
In a large company with several different departments, you may have to divide the 
staff into different access groups. This way you can decide which doors the 
different groups should have access to – and during which hours they should have 
access to these doors. For example, you can programme that the reception staff 
should not have access to the research department during lunch; at the same time 
as both the reception staff and the research staff should have access to common 
doors during all time zones. Each person may belong to six access groups at the 
most. 

Access registration 
If desired, you can have information about transactions and other events printed 
regularly. You decide for which doors and during which time zones this should be 
possible. For example, you can request printouts of all transactions at night 
through the main entrance. The printout states which door has been used, what 
time and the names of the people who used the reader. 

Bewapass/Entro furthermore offers the possibility to choose the types of events to 
be registered. For example, you can choose to show only whenever a door is left 
open or whenever a alarm occurs, or only show exceptions (i.e. not to show normal 
transactions.) 

You may choose whether registered events should be printed or displayed on the 
PC’s screen. If the events should be printed you can choose which printer they 
should be printed to. 

Events are stored in event files on the PC’s hard disk. To free disk space the 
system can be set so that event files are deleted after a specified time or when a 
specific file size is obtained. 
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Zones 
Four different zone types can be created: 

• Alarm zones 

• Antipassback zones 

• Roll call zones 

• Entrance limitation zones 

Zones are created in the Bewapass Installer program. 

Alarm zones 
An alarm zone includes one or several doors leading to the same alarm-protected 
area, where alarm by-pass is required at all doors. Alarm zones are defined in the 
Bewapass Installer program. 

It is possible to combine the functions of manually activating the alarm and/or an 
automatically activating the alarm. I e if nobody activates it – Bewapass/Entro 
secures this is done. 

The alarm control function enables you to determine which people should be 
authorised to activate and deactivate an intruder alarm system linked to Entro. As 
you are defining the access groups you will also be able to distribute the proper 
alarm by-pass authorisation. 

The following authorisation types exist: 

• None. No authorisation. 

• Activation. Authorisation to activate the alarm system. Suitable for e.g. 
cleaning staff, who will be there before the end of working hours, and will be the 
ones to activate the alarm. 

• Deactivation. Authorisation to deactivate an alarm. 

• Activation/deactivation. Authorisation to activate and deactivate an alarm. 

Antipassback 
Creating antipassback zones is a way to further increase security. Antipassback 
means that a cardholder cannot enter another (or the same) zone unless he has 
not registered, using the card, that he has entered and left a zone. If a user violates 
antipassback, i.e. does not use his card to leave the zone and then tries to enter 
the same zone or another zone, the card will be blacklisted. 

On each side of a door leading to an antipassback zone, an IN reader and an OUT 
reader should be installed. 

Antipassback zones are defined in Bewapass Installer. In Bewapass/Entro, it is 
possible to specify for how long a card should be blacklisted if a person violates 
antipassback (see the Programming chapter on page 30). 

If antipassback zones have been defined, roll call zones are automatically created, 
enabling you to monitor a person’s whereabouts in the Door and event monitor 
(see the Door and event monitor chapter, the Roll call section on page 48). 

Note! Antipassback works only with the Card or Card+PIN security levels. 
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Roll call 
Just like antipassback, roll call requires IN and OUT readers to be installed on 
each side of the doors belonging to the zone. By defining roll call zones a person’s 
whereabouts in the premises can be monitored in the Door and event monitor 
(see the Door and event monitor chapter, the Roll call section on page 48).  

The only difference between roll call and antipassback is that antipassback 
includes the feature that cards will be blacklisted if a user does not use his card to 
leave a zone he has previously entered. 

Roll call zones are defined in Bewapass Installer.  

Note! Roll call works only with the Card or Card+PIN security levels. 

Entrance limitation 
A building can have areas where access should be allowed to a certain extent. In a 
school dining hall for example, a card may grant the cardholder one meal a day. 
To prevent the card from being passed to other persons, an entrance limitation 
zone can be created for this particular area (this is done in Bewapass Installer). 

Later, in Entro, an access group can be created with the desired entrance 
limitations – either a counter (a certain number of entries are allowed) or limited 
access (e.g. once a day) or a combination of both. 

In the dining hall example, the system could be set so that the card can be used 
once a day for 20 days. 

Using entrance limitation with a counter, it is possible to specify an individual 
number of granted entries for each person in the access group. 
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Preparations 
Before you start programming the system’s basic information, you should think 
about how the system should function in the building. During which hours should 
entry through the main entrance be permitted? Do certain people need to have 
access 24 hours a day? Who should have access to the research department?  
How does the cleaning staff get inside the building in the morning or evening? 

Whatever the questions are, the answers will become clear as you fill in the charts 
described in this chapter. You will have plenty of time to decide upon time 
schedules, time zones access groups etc.  Then you will use the filled-in charts as 
an aid during programming. You will find the charts at the back of this manual. 
Take a few copies of each chart and follow the instructions below. 

If you also intend to use reservation functions – see section Preparations – 
Reservation on page 56. 

Decide on time schedules and time zones 
The first thing to do is to identify the different types of working hours or other time 
divisions in the premises. Then decide what time schedules to be used. Finally, 
decide what time zones to be used within each time schedule. 

1 Take a copy of the Time schedule chart and enter the name of the first time 
schedule. If you need more time schedules for your premises, fill in another 
copy of the chart. 

2 Enter the names of the time zones in the Time zone 1 and Time zone 2 fields. 
You can enter three time intervals per day for each time zone. 

3 Enter the time intervals included in each time zone. The time zone for working 
hours may be interrupted for an hour by the Lunch time zone, and must be 
divided into two intervals. If there is a night shift you can use the third interval. 

The following example shows a completed chart: 

Time schedule: Office hours 
Time zone 1: Working hours Time zone 2: Lunch 
Day From To From To From To Day From To From To Fro

m 
To 

Monday 08:00 11:59 13:00 16:59   Monday 12:00 12:59     
Tuesday 08:00 11:59 13:00 16:59   Tuesday 12:00 12:59     
Wednesday 08:00 11:59 13:00 16:59   Wednesday 12:00 12:59     
Thursday 08:00 11:59 13:00 16:59   Thursday 12:00 12:59     
Friday 08:00 11:59 13:00 16:59   Friday 12:00 12:59     
Saturday       Saturday       
Sunday       Sunday       

 

In the above example, two time zones have been chosen for the Office hours time 
schedule: Working hours and Lunch. The unspecified hours i e the remaining 
time, are always called Other time. This time zone is the third time zone. 

Tip! If you create separate time schedules for Doors and Access groups, you can 
easily change times for security level of the door – or change times for only 
authorities of the different access groups 
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Doors 
The next chart to fill in refers to the different doors in the building. On the installer’s 
Doors chart, the installer has already filled in the names of the doors to be provided 
with a card reader. 

1 Study the installer’s Doors chart/s and copy the door names and addresses to 
your blank copy of the user’s Doors chart. 

2 Enter the door’s opening time in the Opening time field.  

The time available to open the door after a valid card has been swiped and/or 
a valid PIN code has been entered. If the door is not opened during this time, it 
is locked again. Recommended opening time is 7 seconds. You can choose 
an opening time between 1 and 99 seconds. 

3 Enter the desired door held warning time in the Door held warning time field. 

If the door is still open when the opening time is over, a buzzer sounds at the 
door for the time set as door held warning time. The buzzer reminds the 
person entering to close the door immediately as an alarm is about to go off. 
Recommended door held warning time is 20 seconds. You can choose a time 
between 1 and 99 seconds. 

4 In the Time schedule field, enter the name of the time schedule applying to 
the door. 

5 In the fields under the Time zones heading, enter the names of the time zones 
included in the time schedule. 

6 In the fields under the Security levels heading, enter which security levels 
should apply during the different time zones.  

7 Under the AR (access registration) heading, put a cross next to the time zones 
during which the system should store information about transactions. 

8 Under the RO (remote opening) heading, put a cross next to the time zones 
when remote opening should be enabled. 

9 Under the BL (background lighting) heading, put a cross next to the time 
zones when background lighting should be turned on. 

10 Under the MU (motor lock unlocked) heading, put a cross next to the time 
zones when the motor lock should be unlocked. Does only apply to doors 
controlled by DC21 and set to control motor locks. 

11 Under the Operated from PC heading, put a cross if the door can be operated 
(e.g. remote open) directly from a PC. 

12 Put a cross in column CT if the door also temporarily is allowed for changing 
security level (Unlocked or Group code) by an authorised card belonging to an 
access groups marked as Caretaker. 

13 In the Security level in off-line condition field, enter which security level 
should apply in case there is a communications breakdown in the system. This 
is only true of doors where the DC21 door controllers with additional readers 
are installed. For doors connected to DT05 door terminals, you can only 
choose whether the door should be locked or unlocked. 

The following example shows a completed chart: 
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Door name and 
address 

Open. 
time 

Door held 
warn time 

Time 
schedule 

Time zones Security 
levels 

AR RO BL MU Operated 
from PC 

CT Security level in 
offline condition 

Working 
hrs Unlocked  X  X 

Lunch Card  X  X Entrance 07 20 Office 
hours 

Other time Card+PIN X  X  

X X Card+PIN 

Working 
hrs Card  X   

Lunch Card  X   Stock 10 40 Office 
hours 

Other time Kort+PIN  X   

  Door locked 

      
          
Other time      

   

 

Decide on access groups 
Before you decide on access groups, you should identify the departments or 
sections in the premises, what staff groups should have access to these 
departments and during which time zones they should have access. 

For example, the office staff may consist of people working in a number of different 
departments. If you do not want the reception staff to have access to the research 
department’s doors you can programme this. 

This is how to fill in Access groups chart: 

1 Enter the name of the access group in the Name field. 

2 If Group code is one of the security levels; enter the four-digit code to be used 
by the access group in the Group code field. Otherwise leave the field blank. 

3 Choose the desired alarm control authorisation type by putting a cross in the 
desired box under the Alarm control heading (see the Alarm zones section on 
page 10 in the Important concepts chapter).  

4 In the Entrance limitation field, enter the type of entrance limitation used or 
put a cross next to None (see the Entrance limitation section on page 11 in the 
Important concepts chapter). 

5 In the Time schedule field, enter the name of the time schedule applying to 
the access group. 

6 In the Time zone 1 and Time zone 2 fields, enter the names of the time zones 
included in the time schedule. 

7 Under the Access to the following doors heading, enter which doors the 
group has access to. 

If you will not use Reservation – ignore the column Reservation objects. 

8 Choose the time zones during which the group has access to the doors. 

9 Take out a new copy of the chart and follow steps 1 to 8 for the next access 
group. 

The following example shows a completed chart: 



Bewapass/Entro User manual — Preparations 15 

 

  

 

Access group name: Tennis club  Group code: 4711 
Alarm control: None    Activation    Deactivation    Activation/Deactivation    

Entrance limitation: None    Counter    Limited access    Caretaker  

Time schedule Training session 
Access to following doors Time zone 1 Time zone 2 Other time Access to following reservation 

objects 

 Week days Weekends  Tennis court 
Club House Yes Yes Yes Sauna 
VIP Lounge Yes Yes Yes  
Parking – upper level Yes Yes No  
Parking – lower level Yes Yes Yes  

 

Divide people into access groups 
The next step is to divide the staff into access groups, by filling in the Persons 
chart. At the same time you will be creating a list of all employees with an access 
card. You should have the access cards in order to be able to register a card 
number for each person. 

1 In the Name field, enter the person’s name. If you enter the last name first, the 
names can be sorted in alphabetical order according to last name when you 
programme the information. 

2 The empty column to the right of the Name field can be used for a purpose of 
your own choice, e.g. employee number or title. Enter the desired heading in 
the top of the column and then the information applying to the person (see also 
the General settings section in the Programming chapter). 

3 Enter the card number in the Card number field. The number has eight digits. 
If you have a keyboard with a built-in card reader you can swipe the card 
through the reader instead. 

4 If the PIN code is set by the system user (i.e. not by the users at the door 
terminals), enter the PIN code on the line beneath the card number (see the 
General settings section in the Programming chapter). 

5 Enter the access groups to which the person should belong (six at the most). 

6 The field Member group no is mainly intended for setting the authorities in the 
Reservation system but can be used as a free field for numerical information. 
Maximum five digits, 1-15000. 

7 Enter during which period the person is authorised. For example, if you are 
registering an electrician who only needs access during one or two days, you 
can enter a finishing date two days ahead. Simply enter ”–” in the To field if the 
person is authorised until further notice. 

The following example shows a completed chart: 
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Name: Department no Card no and 
PIN-code 

Access groups Member-
group no 

Access 
from 

Access 
to 

Card no Tennis club 

12345678  

PIN  
Gray Eddie 1620 

1234  

1620 020115  

Card no Tennis club 

12345679 Parking 

PIN  
Hunter Norman 1621 

1239  

1621 020701  

Card no Tennis club 

12345680  

PIN  
Sprake Garry 1621 

6534  

1621 020701 020930 

Card no Tennis club 

12345681 Parking 

PIN  
Smith Benny 1622 

2312  

1622 020115  

 

Holidays, half days and holiday periods 
The most common working hours in an office are Monday to Friday with Saturdays, 
Sundays and holidays off. Certain days, e.g. the day before a holiday, you might 
only work a half-day. Perhaps the company applies a fixed holiday period in July. 

To make the system understand that holidays, half days and holiday periods 
should not be treated as ordinary working days, this information must be 
programmed. Holidays and holiday periods are automatically given the time zone 
Other time. 

1 Take a copy of the Holidays, half days and holiday period chart. 

2 Enter the dates of coming half days. Maximum of 14 days. 

3 Enter the dates and names of coming holidays. Maximum of 28 days. 

4 Enter the working hours to apply to each half day. If the working hours are 8–
12 only, one time zone is sufficient. If the working hours are e.g. 8–12 and 13–
15 and a specific security level should apply during the lunch, use both time 
zones (see the example on next page). 

5 In the fields under the Holiday periods heading, enter the dates of fixed 
holiday periods, if any. Maximum of 8. 

You can choose if the days entered here should apply generally in the system, i.e. 
for all time schedules you create, or if they should only apply to a specific time 
schedule. In the latter case, fill in another chart for the days to apply for another 
time schedule. In the Programming chapter you will find instructions on how to 
programme the information. 

The following example shows a completed chart: 
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Half days 

Date Time zone 1 Time zone 2 

From To From To From To From To From To From To 

020430 08:00 11:59 13:00 14:59   12:00 12:59     

020622 08:00 11:59 13:00 14:59   12:00 12:59     

021223 08:00 11:59           

             

             

Holidays 

Name Date 

Halloween 021025 

Christmas Eve 021224 

Christmas Day 021225 

  

  

  

Holiday periods 

Start date End date 

020630 020731 

  

  

  

 

You have now completed all charts. Now you can go to the PC and programme the 
information. Go to the next chapter, Programming. 
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Programming 
When you have completed all the charts, you can programme the information in 
the system. The type of programming described in this chapter is normally done 
only once – when the system is installed. How to manage the running operation, 
e.g. changing, adding and deleting information is described in the system’s Help 
function (see the Using Help section). 

Start the system 
This is how to start Bewapass/Entro: 

1 In Windows, go to the Start menu; choose Program, Bewapass Entro and 
then Entro. The login window is displayed. 

2 Enter bewa in the User Name field and press TAB. 

3 Enter pass in the Password field and click OK. Now you are logged on. 
Bewapass/Entro’s main window is displayed. 

On-line, off-line and database information 
In the bottom right of the box there are two indicators: 

 

If the text ON LINE and a green indicator are displayed, the PC and the 
Bewapass/Entro programme are connected to the access control system.  

 

If the text OFF LINE and a red indicator are displayed, Entro has no contact with 
readers and controllers. This means that the information registered in the PC does 
not reach the segment controllers.  

 

If the text DB UP TO DATE (DB = database) and a green indicator are displayed, 
all segment controllers have the same information as the PC.  

 

If the text DB OUT OF DATE and a red indicator are displayed, the segment 
controllers do not have the same information as the PC. Note that a certain amount 
of time may pass before the information has reached all segment controllers and 
that the system has to be ON LINE for this to be possible.  

 

You can also look at the status bar how far the transferring of data to the PC has 
gone. 

Note! The default setting is that you will automatically be logged out of the 
system if no task is performed within 15 minutes. In the System Administrator 
program you may set the desired number of minutes or disable auto log-off 
(described on page 32). 
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Entro serial communication (Entroser) 
In the bottom right of the window task bar the following symbol is displayed: 

 

Regardless of using network or direct cable to the PC the following information 
applies. 

When displayed, Entroser (Entro serial communication) is running, which is a 
condition for events to be displayed on the PC’s screen. Entroser will be running 
even if you exit Entro. Click the right mouse button on the symbol to display a 
menu, from where you may start Entro (if it is not running) and the Door control 
programme. You can also exit Entroser from here. Shutting off the PC will also exit 
Entroser.  

The indicators (green or red ”LEDs”) function as explained above.  

Time schedules 
The first thing to do is to programme the information about the time schedule/s you 
have defined. Take out the chart/s headed Time schedule. 

1 Click the Time schedules tab.  

2 Click New.  

3 In the Name field, enter the name of the time schedule e.g. Office Hours, and 
press TAB.  

4 In the Name field of Time zone 1 square, enter the name of the first time 
zone, e.g. Work Hours, and press TAB. 

5 In the Name field of Time zone 2 square, enter the name of the second time 
zone, e.g. Lunch Time, and press TAB. 

6 The cursor is placed in the From field far left, next to the Mon. (Monday) text 
in the Time zone 1 square. 

7 Enter the first time interval for Mondays. Enter the time by typing four digits in 
succession, e.g. 0800 for 8.00. Continue with the next time interval, if any. 

8 Press TAB until the cursor is placed in the first From field in the Time zone 2 
square. 

9 Enter the time intervals defined for Time zone 2. 

Note 1! The time intervals must not overlap. If one interval in Time zone 1 ends 
with 1200, the following time interval in Time zone 2 must start with 1201. 
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Copy time intervals 
You will probably want to use the same time intervals for Tuesday’s and the other 
weekday’s working hours. This is how to copy the time intervals defined for 
Monday. 

1 Place the pointer above the Mon. text and click the right mouse button. A 
menu is displayed. 

2 Choose Copy times using any mouse button. 

3 Place the pointer above the Tue text and click the right mouse button. The 
menu is displayed again. 

4 Choose Paste times. The time intervals are pasted – the ones you have 
defined for Time zone 2 as well. 

5 Follow steps 3–4 for the remaining weekdays using the same time intervals. 
Should the working hours be shorter on Friday, it is easy to change that 
interval. 

The time intervals you have defined are illustrated graphically at the bottom of the 
window for you to check that you have programmed the times correctly (see the 
example below).  

 

 

 

 

6 If you want to use the same half days, public holidays and holiday periods for 
all time schedules, i.e. you have only completed one Holidays chart, click OK. 
The Time schedules tab is redisplayed. 

If you want to define specific half days, public holidays, or holiday periods for 
this time schedule, go to the Enter specific half days, public holidays and 
holiday periods section below. 

7 Set up information for the next time schedule in the same way. Start by 
clicking New. 

Hint 1! Instead of clicking New you can click Duplicate. If the information is 
similar, you need only change a few pieces of information, e.g. the name of the 
time schedules. 

Hint 2! You can select a time schedule and right-click to invoke same commands 
as the buttons. 

Other time 

Working hrs

Lunch 

Working hrs 

Other time 

 00.00 – 24.00 hours 
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Enter specific half days, public holidays and holiday 
periods 

If required, for the time schedule you have just defined, you can programme other 
holidays, half days or maybe another holiday period other than the general 
information you entered on the Half days, Public holidays, and Holiday period’s 
chart. Remember that you can combine both general and unique settings (in each 
time schedule) 

Proceed as follows: 

1 Take the copy of the Half days, public holidays, and holiday periods chart 
applying to a specific time schedule. 

2 Click the Half days tab. 

3 Click New. The Half-day window is displayed.  

4 Enter the desired information. In the Half days, public holidays and holiday 
periods section further along in this manual you will find instructions on how to 
enter the information. 

5 If you want, you can mark the tick in the Use Global half-day table box. Then 
also the days programmed in the System settings menu will be displayed - and 
used by this time schedule. 

6 Enter the desired information about other holidays and holiday periods in the 
same way. 

Doors 
The next step is to programme information about doors. Take the completed Doors 
chart and follow the instructions below. 

1 Click the Doors tab.  

Since the installer has already allocated addresses for the doors they are also 
registered with a name in the system. 

2 Select the name (by clicking it) of the door whose information you want to 
enter. 

3 Click Edit.  

The name of the door is displayed in the Name field. 

4 Enter the desired opening time in the Opening time field. Click the up- or 
down arrow respectively to increase or decrease the value, or enter the 
desired value in the field directly. 

5 Enter the door held warning time in the Door held open warning time field. 
Click the up- or down arrow respectively to increase or decrease the value, or 
enter the desired value in the field directly. 

6 In the Time schedule field, choose the time schedule applying for the door. 
Click the down arrow to display a list of available time schedules (the time 
schedules you registered earlier). You can also click on the clock icon to 
Create, Edit or Copy a time schedule. Then choose the desired time schedule 
by clicking the name. 
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7 Choose security levels for the different time zones in the time schedule. Click 
the down arrow to display a list of available security levels. Then choose the 
desired security level by clicking the name. 

8 Choose the suitable security level to apply in the reader in off-line condition 
(e.g. during a communications breakdown) in the same way. Persons 
belonging to the Priority group are the only ones that can open doors in off-line 
condition. 

9 Click the Advanced tab.  

10 Enter the choices you have made for the door concerning access registration, 
remote opening (exit request) and background lighting. 

11 If you have chosen to let the Alert relay control the door’s motor lock (this is 
done in Bewapass Installer), select during which time zones the motor lock 
should be unlocked. 

12 Select the Motor lock stays locked… check box if the motor lock should 
remain locked until the first person unlocks the door, e.g. in the morning. 

13 Enter whether the internal buzzer should sound on key presses or not. 

14 Select the Allow remote control of this door check box if the door should be 
operated from a PC, e.g. opened, via the Door and event monitor program. 

15 You can select how the exit request input shall act (pulsed): 

• Marked means that the door is unlocked the maximum opening time from 
the moment the input is activated. 

• Unmarked results in that the opening time is started from the moment 
the input are inactive. I e the door can be externally controlled and the 
lock relay can be activated longer than the opening time. 

16 Select if this door allows for a temporarily change of security levels to 
Unlocked or Group code by a caretaker. See chapter Caretaker function on 
page 38 how this is managed at the door.  

17 If lift control is applied, you may go to the IOR Relays tab and activate the 
desired relays during certain time zones. By activating the relay for a specific 
floor during a specific time zone, the floor will be accessible without the use of 
cards or code. 

18 Click OK. 

19 Enter information about the next door in the same way. 

Hint! If you select a door and right-click you are able to Edit settings – or Show 
persons to see persons authorised to this door.  

Access groups 
The next step is to register the information entered on the charts headed Access 
group. 

1 Click the Access groups tab.  

2 Click New.  

3 Enter the name of the access group in the Name field.  

4 If a common group code is to be used, enter the code in the Group code field. 
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Note! Group code cannot be entered if PIN without card is allowed (can be set 
in the Bewapass/Entro Installer). 

5 Choose the time schedule for the group by clicking the desired alternative in 
the list next to the Time schedule prompt.  
You can also click on the clock icon to Create, Edit or Copy a time schedule. 

6 Mark the tick box Caretaker if this group is allowed to temporarily change 
security level for certain doors. 

Note! This will also give access to all doors in a Reservation system (without 
reservation). 

7 Select the doors that the persons in this access group should have access to 
and during which time zones they should have access.  

For example, if you want the group to have access to the entrance 24 hours a 
day, select all check boxes for that door. 

If lift control is applied, the floor numbers will be displayed under the name of 
the reader controlling the lift. Select the floors to which the group should have 
access. 

8 Click the Alarm and entrance limitations tab.  

9 Select the suitable alarm by-pass rights for this access group. 

10 If needed, select the desired entrance limitations for the group and the doors 
the group has access to. This can only be done if an entrance limitation zone 
has been created in Bewapass Installer. 

• Counter. Used if access should be limited to a certain number of entries. 
Later you may, for each individual person, specify the number of allowed 
entries (double-click the desired person on the Persons tab and click the 
Duration tab. Can be combined with limited access. 

• Limited access. Used if access should be limited to a certain number of 
entries per day (can be limited further to certain time intervals during the 
day). Limited access is specified in Bewapass Installer on the Zones tab, 
Entrance limitation). Can be combined with the counter. 

11 Click OK. 

12 Set up information about the next access group in the same way. Start by 
clicking New. 

Hint 1! Instead of clicking New, click Duplicate. If the information is similar for 
the next access group, you need only change a few pieces of information, e.g. 
name and group code. 

Hint 2! You can select an access group and right-click to invoke same 
commands as the buttons. 
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Persons 
The next step in the programming is to register the persons to have access to the 
premises and to divide them into access groups. First however, you must make a 
few common settings. 

General settings 
Two settings affect the Person properties window where you enter information 
about persons. To make the settings, proceed as follows: 

1 Choose System settings on the System menu.  

2 In the Title for free data field in “Persons” screen field, you can enter a text of 
your own choice. This text will be displayed as a field title in the Person 
properties window. For example, enter Empl.no: (there is only room for 10 
characters) if you want to be able to enter an employee number for each 
person you register.  

3 There are two alternatives for setting the individual PIN codes: 

• Make sure the button next to At PC is selected if you want to set the 
person’s PIN code on the PC. 

• Make sure the button next to At Door terminal is selected if each person 
should be able to choose his own PIN code at a door terminal (how this is 
done is described in the Setting/changing the PIN code section in the 
Using Bewapass/Entro chapter). 

4 Click OK. 

Information about persons 
To enter information about the people who should have access to the premises, 
take the Persons chart and follow the instructions below. 

1 Click the Persons tab.  

2 Click New.  

3 Enter the name of the first person in the Name field. 

4 Enter the desired information in the free field (see the previous section). 
Maximum 40 characters. 

5 Enter the person’s eight-digit card number in the Card No field. 

6 The field Member group no is mainly intended for setting the authorities in the 
Reservation system but can be used as a free field for numerical information. 
Maximum five digits, 1-15000. 

Note! If personal code without card is allowed (can be set in Bewapass/Entro 
Installer) and the person desires this alternative, click the Personal code 
without card check box. Then enter the desired code in the PIN Code field. 
Do not enter any card number. 

If you have chosen the option to set the person’s PIN code at the PC, enter the 
desired four-digit code in the PIN code field. 

7 If you have chosen the option enabling each person to choose his PIN code at 
a door terminal, the field is greyed out. 
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8 In the Available groups square, the access groups you have defined are 
displayed. Choose which access groups the person should belong to, by 
clicking the box to the left of the desired access group. You can choose up to 
six access groups per person. You can also click on the group icon to Create, 
Edit or Copy an access group. 

9 A tick is shown in front of chosen groups. The group’s name is displayed in the 
Member of groups square. If you want to remove a group, double click the 
name in the Member of groups square. The name disappears. You can also 
click the tick in the box. 

10 Beside the card number there is a tickbox which shows if the the card (person) 
is Active (valid) in the system. This means it is possible to keep settings for 
card but not yet authorised for use. This can also be changed by right-clicking 
a name in the card list. 

11 Click the Duration tab.  

12 In the Start at field, enter from which date the person should be authorised in 
the system. Today’s date is automatically displayed.  

13 If you want to choose another date, enter the date directly, according the 
yymmdd format, e.g. 000521, or click the Calendar button (in the Calendar 
section on page 36 you will find instructions on how to use the calendar). 

14 The Until further notice alternative is pre-set, which means that the person is 
authorised in the system until you or another system user registers an end 
date. You can however enter an end date straight away. Click the button next 
to End at and enter the desired date. 

15 Select Restrict and enter the maximum number of entries allowed, if the 
persons access rights to certain doors should be limited. Use this alternative if 
the person belongs to an access group with entrance limitations. 

16 Click OK. The Persons tab is re-displayed with the name of the person you 
registered. 

17 Register the next person in the same way. Start by clicking New.  

Hint! You can select one (or more) persons and right-click – and you can 
choose among several commands. E g to make the card inactive, show 
authorised doors, export information etc. 



26  Bewapass/Entro User manual — Programming 

 

  

Duplicate a card  
Instead of clicking New, click Duplicate. If the information is similar you need only 
change a few pieces of information, e.g. name and card number. You may only 
need to change a few digits in the card number. 

Hint! You can also select a card and then right-click to Duplicate the card. 

Duplicate to several cards 
When the system is new maybe the card numbers are in a series. You can easily 
programme these into Entro by using the extended duplicate function. Proceed as 
follows: 

1 Enter the first card as usual. 

2 Select the card to duplicate, if not marked, and click on the double arrows to 
the right of the Duplicate button. 

3 In the field Number of copies the amount of duplicates you need. 

4 Enter the first card number – or use the suggested (which is one higher than 
the selected card). 

5 In the Name field there are two choices: 

1. Click the actual name and decide what number to add to it. The card 
number is then incremented with one and the name will get a suffix (added 
with one for each).  
E g if a name Visitor is marked in the above – the next name will be Visitor – 
x (where x is the entered number). 

2. Click Same as card number - and the card number is incremented and 
copied to the Name field.  

6 Click OK. 

The same access group settings etc will apply to these duplicates. 

Show persons authorities for doors 
In the list of persons it is easy to get information about the authorised doors of a 
specific person. Proceed as follows: 

1 Start Entro and the list of persons are displayed. 

2 Select a person. 

3 Right-click and choose Show doors and a list of the doors is shown. 

4 Click on Close (or Print). 
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Half-days, public holidays and holiday periods 
The next step is to programme half days, public holidays and holiday periods to be 
used generally in the premises. Remember that you can combine both general and 
unique settings (in each time schedule). Take out the Half-days, Public holidays 
and Holiday period’s chart. 

Half days 
Proceed as follows: 

1 Choose System settings on the System menu.  

2 Click the Half days tab. 

3 On the Half days tab, click New.  

4 Enter the date of the first half-day in the yymmdd format, e.g. 000430, or click 
the Calendar button (in the Calendar section on page 36 you will find 
instructions on how to use the calendar). 

5 Place the cursor in the leftmost From field under the Time zone 1 heading. 

6 Enter the working hours to apply for the first time interval during Time zone 1. 
Type four digits in succession, e.g. 0800 for 8.00. 

7 Enter the working hours to apply for the second time interval during Time 
zone 1.  

8 Enter time intervals for Time zone 2, if any, in the same way. 

Note! The time intervals must not overlap. If an interval in Time zone 1 ends 
with 1200, the following time interval in Time zone 2 must start with 1201. 

9 Click OK. The Half days tab is redisplayed with the new half day registered. 

10 Proceed the same way to register the next half-day according to the chart. 
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Public holidays 
Below you will find instructions on how to programme the public holidays of the 
year. Holidays belong to the Other time zone. 

1 Click the Public holidays tab.  

2 Click New.  

3 In the Date field, enter the date of the first holiday in the yymmdd format, e.g. 
000501, or click the Calendar button (in the Calendar section on page 36 you 
will find instructions on how to use the calendar). 

4 Click OK. The Public holidays tab is redisplayed with the date filled in.  

5 Click New and programme the next holiday accordingly. 

Holiday periods 
1 In this section you will find instructions on how to enter holiday periods, if any. 

Holiday periods belong to the time zone Other time. 

2 Click the Holidays tab. 

3 On the Holidays tab, click New.  

4 Enter the starting date of the holiday period in the yymmdd format, e.g. 
000630, or click the Calendar button (in the Calendar section on page 36 you 
will find instructions on how to use the calendar). 

5 Enter the ending date of the holiday period in the yymmdd format, e.g. 000831, 
or use the calendar. 

6 Check that the information is correct, and then click OK. The Holidays tab is 
redisplayed with the holiday period filled in. 

7 Click OK to close the Holidays tab. 
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Supplementary information 
In this section a couple of additional settings you can make in the system are 
described. 

Priority group 
Using this function you can determine which persons should be able to open a 
door in case of a communications breakdown in the system. Note that this only 
applies for doors controlled by the DC21 door controller.  

This is how to decide which persons should have this authorisation: 

1 Choose System settings on the System menu.  

2 Click the check box to the left of the person to be included in the group. A tick 
is shown in the box and the name is copied to the Priority persons square. 

Note! To withdraw the authorisation, double click the name in the Priority 
persons square or click the tick. 

3 Click OK. 

Register system users 
In Bewapass/Entro you can register several system users, i.e. several people with 
authorisation to programme the system. 

Note! The persons appointed as system users must also be registered in the 
system as persons. In the Information about persons section on page 24 you will 
find instructions on how to do this. 

This is how to register system users: 

1 Choose System users on the System menu.  

2 The names of existing system users are displayed in this window. If you have 
not registered any system users yet, the window is empty. 

3 Click New. The Create new window is displayed. 

4 Select System user and click OK.  

5 Click the down arrow in the User field to display a list of registered persons. 

6 Select the desired name. 

7 Choose a password and enter it in the Password field (five characters at the 
most). 

8 Enter the password once again in the Verify password field. 

9 Choose the desired user level for the system user you have registered.  

Note! The first time you register a system user you can only choose the All 
rights level. The reason for this is that there has to be at least one system 
user with authorisation to perform all tasks in the system. Also note that the 
user name bewa and the password pass will disappear as you register a 
system user for the first time. 
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If the person should have authorisation to make all types of changes in the 
system, choose All rights (level 1). 

If the person should have authorisation to all functions except the ones 
reached from the System menu, choose All rights except system 
properties (level 2). 

If the person should only have authorisation to register, change and delete 
information about persons, choose Person properties only (level 3). 

10 Click OK. The List of system users window is redisplayed with the name of the 
new system user.  

11 Click Close. If you exit Bewapass/Entro now you can log in with the user name 
and password you just registered. 

If you want more persons to have authorisation to programme Bewapass/Entro, 
proceed the same way to register user names, passwords and rights for these 
persons. 

Duress code on/off 
With the Duress function activated, a person entering the building is able to enter a 
specific code if forced to open the door under threat. Doing so, an alarm signal is 
sent to a connected alarm transmitter. When Bewapass/Entro is delivered the 
duress function is deactivated. 

This is how to activate the function: 

1 Choose System settings on the System menu.  

2 Click the Enable duress button. A warning message is displayed. 

3 Click Yes to activate the duress function. 

Antipassback violation 
If a person violates antipassback, i.e. does not use his card to leave a zone and 
then tries to enter the same zone or another zone, the card will be blacklisted. This 
function is used to specify for how long the card should be blacklisted. 

1 Choose System settings on the System menu. 

2 Click the Antipassback tab. 

3 Choose the desired alternative. 
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Automatic deletion of events 
In Bewapass/Entro, information about events in the system, e.g. entries, are stored 
daily. To free disk space, event files can be deleted automatically after a certain 
time or when a certain file size is obtained. 

Proceed as follows: 

1 Start the System Administrator. 

2 Click the Events tab. 

3 Select when events should be deleted: 

• By time. Select the check box and pull the indicator to the desired number 
of days. Event files where the latest event is this old will automatically be 
deleted. 

• By size. Select the check box and pull the indicator to the desired file size 
in Megabytes. The entire event file is deleted when this file size is obtained. 

4 Select if event files should be moved to the waste paper basket when they are 
deleted or if they should disappear at once. 

5 Click OK. 

Backup of event files 
In cases where you want to archive events files (stored on the PC hard disk) on 
some other backup media, this can be copied separately. Remember to coordinate 
these operations with the automatic deletion of event files.  

Proceed as follows: 

1 Start Windows Explorer. 

2 Find the program folder where Entro is installed. Normally 
C:/Program/Bewator/Bewapass Entro. 

3 Got the database folder. The first system is stored in Db001. 

4 Select which event files to archive. 

Dependant of the PC environment itself, there is maybe methods of doing this 
automatically. Consult the IT-manager. 
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Backup of the database 
Normally it is sufficient to let the database (with all the settings, persons etc) be 
stored in every SR32i (and in the PC) to keep up the safety and integrity of the 
system. The more segment controllers there are – the more backup copies there 
are. 

However – it is possible to save a PC-file copy of the entire information on a 
backup media. Proceed as follows: 

1 Start Windows Explorer. 

2 Find the folder where Entro is installed.  
Normally C:/Program/Bewator/Bewapass Entro. 

3 Go to the database folder. The first system is stored in Db001. 

4 Copy the file entro.db to a suitable backup disk. 

Dependant of the PC environment itself, there is maybe methods of doing this 
automatically. Consult the IT-manager. 

Auto log-off 
If the Auto log-off function is enabled, Bewapass/Entro, Installer and the Door and 
event monitor will automatically be logged off if the programme has been idle (not 
used) for a certain time. 

This is how to make the desired settings: 

1 Start the System Administrator. 

2 Click the Auto Log-off tab. 

3 In the top box, select whether or not automatic log-off should be applied for 
Entro and Installer and for how long the programs have to be idle before they 
are logged off (pull the indicator to the desired number of minutes). 

4 In the box below, select whether or not auto log-off should be applied to the 
Door and event monitor. 

5 Click OK. 
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Password protection for the System Administrator 
One way of increasing security is to enable password protection for the System 
Administrator.  

Note! This password has nothing to do with the password used when logging on 
to Bewapass/Entro. 

Proceed as follows: 

1 Start the System Administrator. 

2 Click the Password protection tab. 

3 Select the Enable password protection for System Administrator check box. 

4 In the Enter password field, enter the desired password using at least 5 
characters. 

5 In the Verify password field, enter the password once again. 

6 Click Set. 

7 Click OK. 
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Encryption functions in Local Area Network 
Bewapass/Entro uses integral encryption software when communicating in network 
environments. This higher security level is necessary - especially when Entro is 
installed in Internet applications. 

The user of Bewapass/Entro should regularly change the crypto key needed by the 
encryption algorithm. The crypto key will always be stored in the database. The 
algorithm uses 128-bit level. 

Note! The crypto key must be written down and kept in a safe place!  

If the crypto key is not correct the communication is not established – and 
the system must be completely reset and re-programmed.  

Encryption gives higher security 
Because of the fact that network use needs an encryption algorithm the security 
aspects of a system are improved. At the same time this raises some important 
points: 

• Always write down the crypto key as soon as it is changed from the standard! 
• There are no back-ways into the system. I e there is no work-around if the 

crypto key is lost.  
• The only way to re-create a system - is to reset it and re-programme the entire 

information.  

Note! A good advice is to use the default crypto key (used at delivery) until the 
system is completely set-up – and then change. 

Change the crypto key 
1 Start Bewapass/Entro. 

2 Click on System and select Change crypto key. A wizard is invoked to guide 
you further. 

3 Select in which way the crypto key should be created: 

• The System creates the crypto key automatically. 

• You enter the crypto key manually – at least 32 characters. Valid 
characters are 0-9, A-F (hexadecimal, upper case). 

• Use a default (which also is used in the SR32i at power-up – if no 
database yet is loaded). 

4 Click Next. 

5 If you have chosen to enter the crypto key manually – a field appears where 
you enter the 32 characters.  

6 The entered/generated crypto key is shown. Do not forget to write it down 
and keep it in safe place! 

7 Click Next – and the new crypto key is sent to all SR32i.  

Note! All SR32i must be on-line to make the encryption work. 

8 Click OK. 
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Access registration 
In Bewapass/Entro you can easily display information about what equipment is 
connected to each segment controller in the system, e.g. a PC or a printer. 
Furthermore, you can decide about which doors information should be registered 
on printouts or be displayed graphically on your PC’s screen. 

1 Choose Controllers Event filters on the System menu. The Controllers 
window is displayed. 

The names on the tabs correspond to the different segment controllers. In the 
Connect controller to square, the equipment connected to the segment 
controller is displayed. 

2 Click Doors. The Door monitor filter is displayed. 

3 Choose the doors to be monitored. For these doors only events will be 
registered on the PC’s screen. 

4 Click OK. The Controllers window is redisplayed. 

5 Click Events. The Event filtering window is displayed. 

6 For each Event group, choose which events to be printed to the printed or be 
displayed on the PC. 

Click the text, e.g. Valid access, to view the events belonging to this Event 
group. Then filter the events.  

Ignore The event is not registered and cannot be retrieved later. 

Normal The event is shown in the Door and event monitor and on 
printouts. 

Alarm The event is defined as an alarm event, i.e. is displayed in red 
in the Event window. 

To ignore all events in an event group, simply deselect the check box in front 
of the event group’s name. 

Note 1: The events Exit request and Group code is by default set to Ignore 
and are not registered. 

Note 2: Events marked Alarm are always printed, (only to the printers) even if 
you have requested nightly printouts only for this particular door. 

Note 3: Events marked Alarm will also activate the Common SR32I alarm 
relay in the segment controller. In addition, alarm-marked events are displayed 
as popups on the PC’s screen if the Common SR32I alarm relay is activated in 
any of the segment controllers. The popups are displayed even though the 
Door monitor programme is not running, on condition Entroser is running (see 
page 19). 

7 Click OK. The Controllers window is redisplayed. 

8 Choose another segment controller (tab) and enter information about this 
segment controller in the same way. 

In the Door and event monitor chapter on page 44 you will find instructions on how 
to start the monitoring programme on your PC. 
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The calendar 
By using the calendar you can enter a date quickly and easily, with only one mouse 
click e.g. when you are programming holidays or holiday periods. The calendar can 
be reached from all windows where you are requested to enter a date. 

Proceed as follows: 

1 Click the Calendar button. This is what the calendar might look like if you 
clicked on the button in the Holidays window: 

 

2 Choose the desired starting date (applies to holiday periods) by clicking it. The 
date is displayed in the Starting date field.  

3 Choose the desired ending date by clicking it. The date is displayed in the 
Ending date field.  

4 Click OK. The dates are displayed in the window from which you activated the 
calendar. 

By clicking the double arrows you can browse one year backwards and forwards 
respectively. Click the single arrows to browse the calendar one month backwards 
and forwards respectively. 
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Using Bewapass/Entro 
In this chapter, Bewapass/Entro’s functions are described from the viewpoint of a 
person entering the building. How do you get in? How do you set an intruder 
alarm? The following sections give answers to these questions and a few others. 

Entrance 
Persons entering the building can open a door in several different ways, depending 
on the security level: 

• By using their card through the door terminals card reader. 

• By entering a group code 

• By using their card and entering his PIN code 

If the card/code is accepted, the green LED is lit and the lock is opened. 

If the person entering the door enters the wrong PIN code three times in 
succession, the card will be blacklisted and must be re-validated at the PC. To 
indicate that a card is blacklisted for this reason, two asterisks (**) are displayed in 
front of the person’s name on the Persons tab in Bewapass/Entro. Double click the 
person’s name to withdraw the cancellation. 

Switching on and off alarm systems 
To be able to activate and deactivate an intruder alarm system, the person must be 
a member of an access group with authorisation to activate and deactivate alarms. 
Note that certain access groups can have authorisation to activate an alarm only, 
while other access groups may only be allowed to deactivate alarms. 

Activating an alarm system – with card 
1 Press B on the door terminal. 

2 Use the card through the reader and enter your PIN code (depends on the 
current security level). The alarm is activated.  

The door is given the security level chosen in the Installer program (often 
Card+PIN security level), irrespective of the security level applying when the 
alarm was activated. This security level applies until the alarm is deactivated. 

Deactivating an alarm system – with card 
1 Use the card through the door terminal’s card reader. 

2 Enter eventually your PIN code (decide by the current security level). When 
the alarm is deactivated the door is given the security level according to the 
time zones defined. 
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Abort an automatic alarm activation cycle 
If the system application is designed in the way that the alarm activation also is 
done automatically by a time schedule – remaining people in the facility are still 
able to abort an on-going alarm activating cycle. A warning signal sounds during 
this time.  
However - if the warning time is fulfilled there are no possibility to “buy time”. 
Instead the alarm is activated (without any regrets). 

Proceed as follows: 

1 When you hear the warning signal (the alarm will be turned on) – find the 
nearest door (in the same zone). 

2 Use your card – or push the exit button (if allowed). 

3 Entro will go back to the normal state – until next automatic activation is 
started. 

You can remain in the facility until you hear the warning signal again – and repeat 
the steps above. 

Entering the duress code 
This is what the person entering the building should do if forced to open the door 
under threat. 

1 Use the card. 

2 Enter the ordinary PIN code; only add 1 to the last digit in the code. 

Example 1: If the PIN code is 1234, press 1235 instead. 

Example 2: If the PIN code is 1239, press 1230 instead. 

When a duress code is entered, the door is opened at the same time as the 
common SR32i alarm output can be activated in the SR32i (duress has to be 
defined as an alarm event for this to happen). The alarm output is activated for two 
seconds. This is enough to operate an alarm device. 

Note! Duress works only during the Card + PIN security level. 

Setting/changing the PIN code 
This is how a user sets/changes their PIN code. (If “Personal Setting” has been 
activated.) 

1 Press the A button on the door terminal. The yellow LED is lit. 

2 Use the access card through the card reader. The yellow LED is lit. 

3 Enter the old code. If you have no previous code, enter 0000. The yellow LED 
blinks twice. 

4 Enter a new code (four digits). The yellow LED blinks twice. 

Note! The code 0000 cannot be used. 

5 Enter the new code once again. 
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Caretaker functions 
Some doors can be set up to allow for a temporarily change of security level. The 
door can be set Unlocked certain time - or set to Group code (4 digits). The 
command is invoked at - and applies only to - selected door. 

The prerequisite is that the person doing this must belong to an access group the 
Caretaker tick box selected. 

Unlocked 
Proceed as follows: 

1 Press A20 and the yellow LED flashes three times. 

2 Use the card (+ PIN). The yellow LED is lit. 

3 Enter the time when the door is to be locked again. E g 1600 for 4 PM. 

4 The reader sets the door unlocked until the requested time (or a time zone 
change) 

Group code 
Proceed as follows: 

1 Press A21 and the yellow LED flashes three times. 

2 Use the card (+ PIN). The yellow LED is lit. 

3 Enter the time when the door is to be locked again. E g 1600 for 4 PM. 

4 Enter the group code with four digits (not 0000). The yellow LED flashes once 
and the group code will work until requested time (or a time zone change). 
Remote opening from PC will still work. 

Reset door to normal 
To put the door into normal mode again before the requested time - proceed as 
follows: 

When unlocked 
1 Use the same card (+ PIN) in the same reader or use the Toggle reset from 

PC in the Door monitor program. 

2 The door is locked and set to normal mode. 

When group code 
1 Press A21 and use the same card (+ PIN) in the same reader 

2 Press 0000. 

3 Press 0000 once again 

4 The door is locked and set to normal mode. 
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Search, import and export 

Searching registered persons 
Using this function you can search for all the persons granted access in the 
system.  

1 Choose Person on the Search menu. The Search persons window is 
displayed. 

In the Search persons window you can use a number of different search 
concepts in order to search for a person. For example, you can use the name, 
part of the name, the card number, the optional field or one of the access 
groups. You can also combine the search concepts and use ”wildcards” and 
”jokers” (”*” and ”?”). See the examples on the next page. 

2 Enter the desired search concepts. 

3 Choose whether the search should be case sensitive. If the check box is 
selected and the search concept is ”smith” the system will not find ”Smith”. 

4 If the Match all criteria check box is selected, all entered search concepts 
must be matched for the person to be found. This alternative is best when the 
search consists of a combination of search concepts. If the check box is 
empty, only one of the concepts needs to be matched. 

5 Click Search.  

6 The name you searched for is displayed on a new, temporary tab called 
Search result. 

7 You may now, using the Search result tab, change the database information 
for this person. Just select the name and click Edit. To remove the person 
from the database, click Delete. 

If you are not satisfied with the search result, click the Change criteria button. The 
Search persons window is redisplayed. The original search concept is saved for 
you to make the necessary changes. 

When you are finished you can remove the Search result tab by clicking the 
Remove tab button. 

Search, example 
To find all persons belonging to a certain access group, simply select the desired 
access group. In addition it is also possible to select one or more doors in the lower 
frame. 

To find all persons by the name of Smith, enter the last name and an asterisk (*), 
i.e. Smith*. The asterisk (or wildcard) implies that any character and any number of 
characters may be found after the asterisk, the system will find them whatsoever. If 
you have registered the persons with the christian name first, enter the asterisk 
first, i.e. *Smith. 

To find all card numbers beginning with 1234, enter 1234 and an asterisk, i.e. 
1234*. 

Apart from asterisks, question marks (jokers) can be used in the search concept, 
e.g. if you are not sure how the person spells his or her name. The question mark 
represents one character, any character. 

*
? 
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Import and export information about persons 
It is easy to import information about persons to Bewapass/Entro, from e.g. Excel. 
You may also export files to other applications from Bewapass/Entro. 

Enter delimiter 
To be able to import and export files, you have to specify what character to use as 
a field delimiter. 

Proceed as follows: 

1 Start the System Administrator. 

2 Click the Optional functions tab. 

3 Enter in the field Delimiter the desired character, e.g. semicolon. 

4 Click OK. 

Import information 
You can import all information about cards (persons). In the table on next page you 
can see the format. 

1 In Bewapass/Entro, choose Import persons on the File menu. 

2 Find the file to import.  

3 Click Open. 

Export information 
You can also export all information about cards (persons) into a file. Note that the 
PIN-code is encrypted and cannot be understand. However - it can still be imported 
from same file. 

1 In Bewapass/Entro, choose Export persons on the File menu. The Export 
persons to file window is displayed. 

2 Find a folder where the file can be stored. 

3 Type a name for the file in the File name field.  

4 Click Save. 

Note! The name of a group must be identical. Both spelling and lower/upper case 
must be correct. If not – a complete new group will be imported without any 
authorities at all. 
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Create an import file in Excel 
1 Create one empty spreadsheet. E g Remove any Sheet 2, Sheet 3 etc. 

2 The file should be of the format below for each person (row). 

Column Field Format 
A Name Text 
B <empty> - 
C Free text Text  
D Card number 8 digits 
E PIN code 4 digits 
F Valid YY-MM-DD – YY-MM-DD 
G Group 1 Text  (identical to existing group) 
H Group 2 Text  (identical to existing group) 
I Group 3 Text  (identical to existing group) 
J Group 4 Text  (identical to existing group) 
K Group 5 Text  (identical to existing group) 
L Group 6 Text  (identical to existing group) 
M Priority person Yes/No 
N Counter Digits 
O Member group no Digits 
P Card inactive Yes/No 

 

3 Choose Save as on the File menu.  

4 In the File format list box, select the desired delimiter, e.g. semicolon. 

5 Type a name for the file in the File name field and click OK. 

Note 1! The name for a group must be identical to regarding spelling and caps 
lock. Otherwise a new group without any permission at all will be imported. 

Note 2!  Numerical fields in Excel cannot accept leading zeroes. Instead change 
the cell format to text in these cases – before entering the digits. That would be 
the case for card number 00340100. 
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Synchronise Bewapass/Entro with BewaTime/CotagTime 
If Bewapass/Entro is synchronised with the BewaTime/Cotag Time & Attendance 
system, information about persons can be imported to Bewapass/Entro from 
BewaTime/Cotag Time and vice versa. 

This is how to synchronise the systems: 

1 Start the System Administrator. 

2 Click the Optional functions tab. 

3 Select the Enable BewaTime/CotagTime synchronisation check box. 

4 In the Import directory list box, choose a folder from which Bewapass/Entro 
should read files that have been exported from BewaTime/CotagTime. 

5 In the Export directory list box, choose a folder from which 
BewaTime/CotagTime should read files that have been exported from 
Bewapass/Entro. 

6 In the Free field mapping field, specify to which field in BewaTime/CotagTime 
the free field in Bewapass/Entro should be mapped, if necessary.  

7 Click OK. 

 

Entering persons in the Entro program 
If Entro is synchronised with BewaTime/CotagTime (this is done in the System 
Administrator program), type the last name first, then a comma and the first name, 
e.g. Smith,John. This makes the name appear right in BewaTime/CotagTime. 
Names imported from BewaTime/CotagTime are displayed like this in Entro 

Import persons from BewaTime/CotagTime 
If Bewapass/Entro is synchronised with BewaTime/CotagTime, the Import cards 
window is displayed each time you start the system – if there is card information to 
import. 

In the Import cards window, proceed as follows: 

• Click All to import all persons in the window. 

• Select the desired rows and click Selection to import selected rows. 

• Select the desired rows and click Delete to delete specific rows. Then click All 
to import the rest of the information. 

If you discard the window by clicking Cancel, the window can be redisplayed by 
restarting Bewapass/Entro. 
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Door and event monitor 
The Access registration section on page 35 described how to choose which doors 
to be monitored on your PC. Below you will find instructions on how to use the 
Door and event monitor programme. 

1 Start the Door and event monitor.  

2 Choose Event log on the File menu (if the Events window is not already 
displayed). 

Each event defined as Normal or Alarm is displayed (see the Access registration 
section on page 35). Alarm events are displayed in red. The events will appear on 
the screen as they occur. 

Even though the Door and event monitor is not running, alarm events can be 
displayed as pop-ups on the PC’s screen. This requires however that Entroser is 
running and that the SR32I Common alarm output is activated in the segment 
controller connected to the PC. 

Restrict access to the Door and event monitor 
In order to restrict access, Entro can be set so that a user name and password is 
required to start the Door and event monitor. 

1 In Bewapass/Entro, choose Controllers event filters on the System menu. 
The Controllers window is displayed. 

2 Select the Login to Door control required for this controller check box.  

3 Click OK. 

From now on log on is required for the PC connected to this controller. To log on to 
the Door and event monitor, use the same user name and password used to log 
on to Bewapass/Entro. 

Multiple windows with different monitoring focus 
By opening multiple event windows you can monitor different doors, persons, 
events etc in different windows.  

Proceed as follows: 

1 Choose New event log on the Event log menu. A new event window named 
Events:2 is displayed. The first event window is renamed Events:1. 

2 Choose Tile windows on the Window menu. The windows are arranged side 
by side. Both windows display the same events. 

3 Click the right mouse button on the Events:2 window. A menu is displayed. 

4 Choose Change filter. The Change filter window is displayed. 

Now you can choose whatever you want to monitor in this window. For 
example, you can monitor a specific person and/or a specific door. You can 
also customise the event filter, e.g. to limit monitoring to certain types of 
events. 

5 To customise the event filter, click Custom filter. 

6 Click Set filter. The Event filter window is displayed. 
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7 Select which event types to monitor in the Events:2 window, and then click 
OK. The Change filter window is redisplayed. 

8 Click OK. Now you have two event windows monitoring different movements.  

9 To add more event windows, choose New event log on the Event log menu 
and then Tile windows on the Window menu.  

This is what the screen might look like when you are using four event windows: 

 

To simplify monitoring, the event windows can be named. 

Right-click the desired window and choose Name view. The Set name of view 
window is displayed. Name the view and click OK. Filtered and named views will 
reappear even if the program is shut off and restarted. 
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Search events 
All information about events is stored in Bewapass/Entro’s archive. To search for 
old events in the archive, proceed as follows: 

1 Choose Search events in archive on the Search menu. The Event search 
window is displayed. 

2 Like when you are choosing what to display in a monitoring window, you may 
search for events relating to specific persons and doors. Using the custom 
filter you can choose what event types to search for. 

3 Choose the desired settings. 

4 To limit the search to specific dates and times, select the Events after and 
Events before check boxes and state the desired date and time intervals. 

5 Click Search. Events corresponding to your search concept are displayed. 
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Door operation from PC 
The Door and event monitor also includes graphical door status display. This 
where you can operate the door directly from the PC, e.g. open the door. To make 
this possible you have to enable this function for each door to be operated from the 
PC. The option is found on the Doors/Advanced tab.  

1 Choose Door status on the File menu.  

The following symbols exist: 

 The door is locked. 

 The door is unlocked. 

 Alarm event on locked door. Example: The card reader  
has been subject to sabotage. 

 Alarm event on unlocked door. Example: The door held 
 warning time has expired. 

 Unknown status. Displayed when the system is off-line, e.g.  
when you are working with a modem connected system (see the 
Working with multiple systems chapter). 

 Alarm activated. Shows that Entro has understand that an intruder 
alarm is turned on and the door is blocked.  

2 Right-click a door symbol to display a menu where several options for door 
operation is available, e.g. Remote open, Toggle open etc. You can also 
display the door’s event log and open a window displaying the door’s current 
status. 

Note! To be able to operate a door from the PC you have to be logged on and be 
a level 1 or 2 system user, i.e. with all rights or all rights except system settings. 

You can log on by starting Bewapass/Entro and log on, or choose Login on the 
File menu in the Door and event monitor. You can also make log on to the 
Door and event monitor compulsory (see page 44). 
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Open/close all doors 
In case of fire or in other circumstances when all doors need to be opened at once, 
choose All doors open on the Door menu. To close the doors, choose All doors 
reset. 

Note 1! This command will not work over TCP/IP communication. In this case 
only the doors opens that are physically connected to the SR32i that the PC 
communicates with. 

Note 2! To be able to open/close all doors from a PC, you have to be logged on 
and be a Level-1 System user, i.e. with all rights. 

You can log on by starting Bewapass/Entro and log on, or choose Login on the 
File menu in the Door and event monitor. You can also make log on to the 
Door and event monitor compulsory (see page 44). 

Roll call 
If you have created roll call or antipassback zones, the Roll call view shows the 
whereabouts of different persons in the premises.  

1 Choose Roll call on the File menu. The Roll call view is displayed with 
names of persons and the zones they are currently visiting. 

2 The view can be filtered further if needed. Right-click and choose Change 
filter. 

3 To monitor several zones or persons at the same time, right-click and choose 
New roll call view. A new window is displayed. Arrange the windows on the 
screen by choosing Tile windows on the Window menu. Then filter each view 
as desired. 

Reset blacklisted card 
Persons who have violated antipassback, i.e. not used their card to leave a zone 
they have previously entered, and persons that have entered three incorrect PIN 
codes in succession, get their cards blacklisted. This is displayed in the Roll call 
view and in Entro’s Person’s tab with two asterisks (**) in front of the name. To 
reset the card, double-click the name. Note that you have to be logged on in Entro 
or the Door and event monitor to be able to do this. 
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Working with multiple systems 
This chapter describes how to provide a modem-connected system with 
information about time schedules, persons, access groups, doors etc. 

Logging in 
As you log in you can choose which system to work with. 

1 Start Bewapass/Entro. The log on window is displayed. 

2 Enter user name and password. 

3 In the System list box, choose the system you want to programme. 

4 Click OK.  

5 The system’s site name is displayed in the title bar of the window. Otherwise 
the window is empty. The red indicator next to the OFF-LINE text tells you that 
you have no contact with the modem-connected system. 

Dialling the modem connected system 
This is how to establish modem connection with the system you logged in to: 

1 Click the lifted handset symbol or choose Dial on the Modem menu. A 
message is displayed while the system tries to establish a connection. 

2 When the connection is established, the ON LINE indicator is lit green to 
indicate that you have direct contact with the dialled-up system the following 
message is displayed. 

3 Wait until the DB UP TO DATE indicator turns green. This may take a couple 
of minutes since information has to be transferred.  

4 When the DB UP TO DATE indicator is lit green, your PC contains the same 
information as the dialled-up system.  

Programming information 
Now refer to the charts applying to this system and programme the information the 
same way as described earlier in this manual.  

Note! Bewapass/Entro should always be ONLINE (dialled-up) when you 
programme a modem-connected system. This makes information transfer quicker 
and safer. 

When you have finished programming, wait until the green indicator and the DB UP 
TO DATE text is displayed bottom right in the Entro window. Then click the 
replaced handset symbol or choose Hang up on the Modem menu. 
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Starting Door monitor without interrupting the modem connection 
The following symbol is displayed bottom right on the PC’s screen: 

 

Click the right mouse button on the two indicators to display a menu where Door 
monitor is one of the alternatives. In the same way, you can switch from Door 
monitor back to Entro. The modem connection will not be interrupted. 

Logging in to another system 
On the File menu you will find an alternative named Login to another system. 
Choosing this alternative you do not have to exit Entro to programme another 
system. Instead, the login window is displayed for you to log in to the desired 
system. If the modem connection is open when you choose Login to another 
system the current connection will automatically be closed. 
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Printouts 
Bewapass/Entro provides you with two types of printouts: 

• Programmed information. At any time you can print the information you have 
programmed about time schedules, doors, access groups and persons. Print 
the information by choosing Print on the File menu. This type of information 
can only be printed to printers directly connected to your PC. 

• Events. This type of information can be printed to a printer connected to the PC 
or automatically to a printer directly connected to a segment controller. 

Programmed information 
1 Choose Print on the File menu.  

2 Choose what information to print. In the above example the Persons option is 
pre-set. Bewapass/Entro automatically suggests the option corresponding to 
the tab being active when you chose Print. 

The Selected persons, Selected doors etc. options mean that only information 
about the person, door etc. selected on the tab is printed (make your selections 
before you choose Print). By clicking Preview you can view the printout on your 
PC’s screen. 

Events 
Events can be printed from the Door and event monitor.  

Proceed as follows: 

1 Open an event log by choosing Event log on the File menu (if it is not already 
displayed). 

2 Right-click somewhere in the event window. A menu is displayed. 

3 Choose Change filter. 

4 Select the types of events to be displayed. 

5 Click OK. 

6 Choose Print on the File menu. 

View system resources 
You can see how many doors, cards, time schedules that are used in the system. 
Proceed as follows: 

1 Click on the System menu in the Entro program. 

2 Select View system resources. 

3 A graphic bar diagram displays the capacity of the system. 

4 Click OK. 
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Bewapass/Entro Reservation 
Bewapass/Entro Reservation is a software module intended for reservation 
functions (e g in sports arenas, tennis courts, conference rooms etc) and works 
together with the integrated access control system.  

The System Administrator sets which objects (like card readers/doors) are to be 
included and chooses the relevant reservation time schedules. 

The users wanting to reserve times can use an ordinary web-browser (like Explorer 
or Netscape) and login to the address containing the reservation system. 
Alternatively use his/her card in a card reader together with a touch-screen – 
depending on how the system is configured. 

Note! The Reservation module in Version 4 requires that all controllers be of model 
SR32i (or later). 

Integrated Web server 
The SR32i has an integrated (embedded) web server function, which is used for 
reservation applications. It requires that the dedicated SR32i have a static IP-
address and a permanent connection to the Internet (when Internet is used). 

Note! At least one of the SR32i must be equipped with a Memory card for web 
reservation, which will contain the reservation information. 
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Reservation
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How the Reservation system works 
Note that this function requires that the software module be installed at the 
installation. Otherwise re-install Bewapass/Entro again (Repair in Windows 2000). 

Set the Reservation options (System User) 
In the Bewapass/Entro Reservation program a reservation object is created which 
can be a tennis court, conference room – or similar. 

You then choose which card readers (from a table of all installed) to be included in 
the object. (The selected card readers will then not be seen in the ordinary Entro 
program). 

After that you create one or more reservation time schedules, which states 
possible times and days to reserve e g a tennis court. The time schedules are then 
named to simplify their use. 

The reservations objects are then configured further to fit different needs. E g how 
many reservations to book forward – or how many tennis courts there are etc. 

In the main Bewapass/Entro program you then decide which objects different 
access groups can reserve. 

Finally, you decide which access groups and member groups every person 
belongs to. 

Technically the entire reservation information is stored in an integrated web page 
(in a SR32i) with its own IP-address on a network.  

The address to this website is <IP-address>/login.html which should be notified 
to the users of the Reservation system. 

Reservation operation (User) 
When all settings are done, reservation can be done in two ways: 

• Login from a web browser in a computer – where the card number and the PIN 
code is used as a password and identification.  

• Login in with a card reader together with touch-screen (if fitted) - where the 
card number is used for identification. 

You then choose the relevant object and enter the times to reserve. 

Using the reservation object (User) 
When you have booked your reservation you just use your card in the normal way. 

Depending of the configuration of the system, different levels of accesses and 
possibilities are available. E g you can pass through a door some minutes after the 
reserved time (to pick up forgotten things or similar). 
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Important concepts - Reservation 
To be able to programme the system you have to be familiar with the following 
concepts: 

• Reservation Time schedules  
• Reservation objects 
• Security levels 
• Access Groups 
• Persons and Member groups 

Time schedules 
Here you programme different schedules for different objects.  

The intention is that different access groups can reserve one or more objects 
during one or more times – depending of the configuration.  

E g two tennis courts have four separate sessions with exactly the same times 
during Monday to Friday – but first and last sessions are not available on Saturday 
and Sunday. 

Mo - Fr

09:00 - 12:00

Example

Tennis court 1: Time schedule: Training session

Mo - Su

12:00 - 15:00

Mo - Su

15:00 - 18:00

Mo - Fr

18:00 - 21:00

Mo - Fr

09:00 - 12:00

Tennis court 2: Time schedule: Training session

Mo - Su

12:00 - 15:00

Mo - Su

15:00 - 18:00

Mo - Fr

18:00 - 21:00

 

Reservation objects 
Reservation objects can consist of facilities with doors, e g sports arenas, 
relaxation rooms or conference rooms - but also other items such as coffee 
machines. I e something that can be electrically controlled and have a locking 
function. These can then be reserved by different kinds of users (sportsmen, 
employees etc). 

In a reservation object there can also be included doors that must be passed 
before you reach the reserved object. Note that these doors cannot be used for 
normal access. (Compared with the rest of the doors in Entro). 
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Security levels 
The security level determines what action is needed to open a door. Because the 
reservation function has to know which person is using the objects only the 
following alternatives are possible: 

• Card only.  A personal card is to be used in the reader to be able to open the 
door. If the card is lost or stolen it is easy to cancel the card. 

• Card + PIN. The door is opened when the access card is used and a personal 
code belonging to this particular card has been entered. 

In other card readers in the Entro-system other levels can be used – see the Users 
Manual. 

Access Groups 
In a large company with several different departments, you may have to divide the 
staff into different access groups. This way you can decide which doors the 
different groups should have access to – and during which hours they should have 
access to these doors. For example, you can programme that the reception staff 
should not have access to the research department during lunch; at the same time 
as both the reception staff and the research staff should have access to common 
doors during all time zones. Each person may belong to six access groups at the 
most. 

In this part you also choose which Reservation object a certain access group can 
book. 

Persons who always should have access to the reservation object – e g caretakers 
– can belong to an access group with this possibility. 

Persons and Member groups 
In addition that every person have his/her own personal card and belong to at least 
on access group, you also shall decide a member group for each person. Every 
member group shall be considered as equivalent and have the same access for 
reserving/changing the same object.  

E g in sports club different teams can form a member group who could book, 
change or cancel times for each other. 
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Preparations - Reservation 
Before you start programming the system’s basic information, you should think 
about how the system should function in the building. How many objects will be 
used? Which times should be able to reserve? Do certain people need to have 
access 24 hours a day? 

Whatever the questions are, the answers will become clear as you fill in the charts 
described in this chapter. You will have plenty of time to decide upon time 
schedules, time zones access group’s etc.  Then you will use the filled-in charts as 
an aid during programming. You will find the charts at the back of this manual. 
Take a few copies of each chart and follow the instructions below. 

Decide on time schedules 
The first thing to do is to identify the times for reserving. In a tennis court there 
maybe are three-hour sessions, which can be booked all the week around – or 
some other object only available on weekdays. 

In the system there can be 32 time schedules with each 24 intervals for 
reservation. 

1 Take a copy of the Reservation Time Schedule chart and enter the name of 
the first time schedule. If you need more time schedules for your premises, fill 
in another copy of the chart 

2 Enter Start and Stop for each interval needed. 

3 Enter the Days the interval should be valid. 

 The following example shows a completed chart: 

Name of Time schedule: Training session 

Interval Day of week 

Start Stop Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

09:00 12:00 Yes Yes Yes Yes Yes   

12:00 15:00 Yes Yes Yes Yes Yes Yes Yes 

15:00 18:00 Yes Yes Yes Yes Yes Yes Yes 

18:00 21:00 Yes Yes Yes Yes Yes   
 

In the above example four intervals have been chosen for time schedule Training 
session of which two does not apply for Saturday and Sunday. 
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Public Holidays and Holidays 
Certain day’s reservations might not be available. E g if tennis court is used for a 
tournament – or if a golf court has closed for the season. 

In the ordinary Entro system there are the concepts Public Holidays and Holidays, 
which means an exception from an ordinary week. These can also be used in the 
reservation system to inhibit reservation on these times. 

Mostly they do not coincide and must be specified for each separate time schedule 
– in the Reservation program. 

To make the system understand that holidays and holiday periods should not be 
treated as ordinary working days, this information must be programmed.  

1 Take a copy of the Public Holidays and Holiday – Reservation chart. 

2 Enter the names and dates of forthcoming Public holidays – or other special 
days not intended for booking. You can have max 14 days in each time 
schedule. 

3 In the fields under the Holidays heading, enter the dates of fixed holiday 
periods, if any. You can have max 4 periods in each time schedule 

4 Fill in another chart with days valid for another time schedule. 

The following example shows a completed chart. 

 

Public Holidays    Use Global Public Holidays table (specified in the Entro program) 

Date Name 

021224 Christmas Eve 

021225 Christmas Day 

030101 New Years Day 
  

  

Holiday  Use Global Holidays table (specified in the Entro program) 

Starting date Ending date 

020608 020614 
  

 

In the above example an object is closed certain public holidays and a whole week 
for renovation. 
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Decide on doors, security levels and reservation 
parameters 

Next charts to fill in are the object conditions and decide which card readers to use. 
We now give an example of a tennis park with two separate courts and main 
entrance. 

Doors for reservation or ordinary accesses? 
You have to consider which doors/card readers to operate by the reservation 
program and which to be operated by the Entro main program. Doors in the 
Reservation system cannot be used as doors in the main system (like entrances, 
parking etc). The reservation doors have to be booked before use. 

Decide on reservation object 
1 Take a copy of the Reservation object chart and enter a Name for the object. If 

you have more objects, fill in another copy. You can have up to 64 objects. 

2 Fill in the Time Schedule to use for the object – i e which intervals are 
available for booking. 

3 Enter how many Maximum no of concurrent reservations on same object 
allowed. E g if a tennis park have two separate courts but only one door, two 
different member groups must still be able to book the same time. Max value is 
99. 

4 Decide the Maximum reservations per member group for a certain forward 
period. E g to book four training sessions in a month. Max value is 4. 

5 Enter in the field Forward reservation time for how long a period booking is 
available. E g 31 days. Max value is 365 days. 

6 Decide on how many minutes the system waits until an automatic cancel is 
done.  Fill in the field Automatic cancel time. This gives a delay before some 
other Member group can book the same time. Max value is 60 minutes. 

7 Enter the allowed Overlap time for accessing the object after the reserved 
time. This makes it possible to enter a booked tennis court some minutes later 
(due to traffic jam or similar). Max value is 99 minutes. 

8 Fill in Available Card readers/Doors that comprise the object. 

9 Mark in the column Selected (common) which doors (not for booking) – but 
must be passed before reaching the object. E g if a tennis park have a main 
entrance to all the courts but people have booked separate courts (with own 
doors); they must be able to pass this common door. 

10 Mark in the column Main reader for reservation, which card readers, to be 
able to reserve in this object. I e if the tennis court has its own door – this is 
actually the door to book.  

11 Choose Security level (Card only or Card+PIN) for all card readers.  

12 Enter Opening time in seconds. I e how long time the door is unlocked for 
access. Max value is 99 seconds. 

13 Enter Door Held Warning Time in seconds. I e how long time the door further 
can be open. Max value is 99 seconds. 

The example on next side shows a completed chart. 
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Example 
In the example there is a tennis park with a Main entrance (reader 1), a door to the 
Tennis Courts (reader 2) with two separate courts and a separate Dressing room 
(reader 3).  

• Two courts can be used free, but the access to the courts itself be seen as an 
object. Maximum two bookings (two member groups) for two courts can be 
reserved on this door. The Main entrance (common) must be included in the 
object. 

• The dressing room is a different object and can only be booked by one 
member group. The Main entrance (common) must also be included in this 
object. 

Every member group can book max 4 times in 31 days. In addition the system 
waits 10 minutes before cancellation and allows for entering the court 10 minutes 
after the actual time reserved. E g to pick up forgotten things or similar. 

Chart 1 – Tennis courts 
Name of reservation 
object: Tennis courts Time 

schedule: Training sessions 
Max no of 
concurrent 
reservations: 

2 

Max reservations per 
Member group: 4 

Forward 
reservation 
time: 

31 Auto cancel 
time (minutes): 10 Overlap time 

(minutes): 10 

Available Card 
readers/doors Selected (Common) Main reader Security level Opening 

time (sec) 

Door Held 
Open Warning 
Time 

Main Entrance Yes  Card+PIN 15 30 
Tennis courts  Yes Card 10 30 
      
      
      

 

Chart 2 – Dressing room 
Name of reservation 
object: Dressing room Time 

schedule: Training sessions 
Max no of 
concurrent 
reservations: 

1 

Max reservations per 
Member group: 2 

Forward 
reservation 
time: 

31 Auto cancel 
time (minutes): 10 Overlap time 

(minutes): 10 

Available Card 
readers/doors Selected (Common) Main reader Security level Opening 

time (sec) 

Door Held 
Open Warning 
Time 

Main Entrance Yes  Card+PIN 15 30 
Dressing Room  Yes Card 10 30 
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Access groups 
So far you have created your reservation objects. Now you have to decide on when 
and who can use them. First you create/re-create access groups. Using the earlier 
Access group charts intended for other parts of the Bewapass/Entro system and 
completing them with new information does this.  

Note! Below are only described the parts concerning Reservation.  

Take a copy of the chart Access groups. If you have more access groups - just fill 
in another copy of the chart. If an earlier chart exists, transfer the information and 
complete it as follows: 

1 Enter which Reservation objects this access group is allowed to reserve and 
use. 

2 Mark if this access group also should have free access to these objects. E g to 
make it possible for Caretakers to get access around the clock.  

The following example shows a completed chart. 

 

Access group (name): Wimbledon Tennis Club Group code: 4711 
Alarm control: None    Activation   Deactivation    Activation/Deactivation ❒  

Entrance limitation: None    Counter   Limited access   Caretaker   
Time schedule Training session 
Access to these doors Time zone 1 Time zone 2 Other time  Access to following reservation 

objects 

 Week days Weekends   Tennis courts 
Club House Yes Yes Yes Sauna 
VIP lounge No Yes No  
Parking – upper level Yes Yes Yes  
Parking – lower level No No No  
     

 

The example shows an access group (tennis club) with different possibilities for 
entering the premises at different times and that the access group can also reserve 
times on a tennis court and in a sauna.  

Note! The stated times schedules are used for ordinary doors and not for doors 
used in reservation objects. Instead reservation doors have their own Time 
schedules – set under Reservation. 
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Persons and Member group 
This is the last part of the preparations. Now you have to decide on which persons 
allowed to book and decide which member group every person belongs to.  

Using the earlier Persons chart intended for other parts of the Bewapass/Entro 
system and completing it with new information do this.  

Note! Below are only described the parts concerning Reservation. If an earlier 
chart exists transfer the information and complete it as follows: 

1 Enter the member group a person belongs to. All persons belonging to the 
same member group number will automatically have the same rights in the 
reservation system. Could be e g training groups, families etc. 

2 Check that the access group allocated to a person has the correct reservation 
object associated (see access groups). 

The following example shows a completed chart. 

 

Name: Family Card no and 
PIN-code 

Access groups Member 
group 

Access 
 from 

Access 
to 

Card no Wimbledon Tennis Club 

12345678  

PIN  
Bill Smith 1620 

1234  

1620 010115 
Until 
further 
notice 

Card no Soho Tennis Club 

12345679 Parking – upper level 

PIN  
John Peterson 1621 

1239  

1621 010701 
Until 
further 
notice 

Card no Soho Tennis Club 

12345680  

PIN  
Jane Peterson 1621 

6534  

1621 010701 
Until 
further 
notice 

Card no Wimbledon Tennis Club 

12345681  

PIN  Stewart Anderson 1622 

2312  

1622 010115 
Until 
further 
notice 

 

 

The example shows that John Peterson (member group 1621) can reserve an 
object that Jane Peterson can use (or change the reservation). 
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Programming - Reservation 
When you have completed all the charts, you can programme the information in 
the system. The type of programming described in this chapter is normally done 
only once – when the system is installed. How to manage the running operation, 
e.g. changing, adding and deleting information is described in the system’s Help 
function. 

Start Reservation 
1 Go to the Start menu; choose Program, Bewapass Entro and then 

Reservation. The login window is displayed. 

2 Enter bewa in the User Name field and press TAB. 

3 Enter pass in the Password field and click OK. Now you are logged on. 
Bewapass/Entro’s main window is displayed. 

Time schedules 
The first thing is to use the Reservation Time schedules chart. Programme the 
information as follows: 

1 Click the Time schedules tab.  

2 Click New.  

3 In the Name field, enter the name of the time schedule e.g. Training sessions, 
and press TAB.  

4 Click New to create a new Interval. 

5 Click on the arrow at Start and choose time. Press TAB. 

6 Click on the arrow at Stop and choose time. Press TAB. 

7 Select the Days when the interval should be valid. 

8 Click OK. 

9 Repeat step 4-8 for every new interval. 

10 Click OK to save the time schedules. 

Set up information for the next time schedule in the same way.  
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Enter public holidays and holiday periods 
You should now programme the holidays and holiday periods, which could apply 
especially for the reservation system. 

Proceed as follows: 

1 Take the copy of the Public Holidays and Holiday – Reservation chart 
applying to the specific time schedule. 

2 Click the Public holiday tab. 

3 Mark the tick in the Use Global Public holidays – if you prefer to use the 
same as specified in the main Bewapass/Entro program. 

4 Click New. The Public holidays window is displayed.  

5 In the Date field, enter the date of the first holiday, or click the Calendar button 
and choose the date. 

6 Click OK. The Public holidays tab is redisplayed with the date filled in.  

7 Click New and programme the next holiday accordingly. . 

8 Create the Holidays in the same way – but enter both Start and End date. 

9 Repeat steps 2-8 for every separate time schedule in the reservation system. 

Doors 
Now you take the chart Reservation object to start programming, which 
doors/cardreaders to include in the total reservation objects - and not to be used 
for the main access system. Also you set-up the parameters for each door. 

1 Click the Doors tab.  

2 Click Add/Remove. 

3 Click on the Available doors (cardreaders) in the left window. All existing 
doors in the entire Entro system are listed. The doors you select will appear in 
the right window. These doors will then not be seen in the door menus in the 
main Entro program. 

4 Click OK. 

5 Mark the name of the doors to edit the parameters needed. 

6 Click Edit. The name of the door is displayed in the Name field. 

7 Enter the desired Opening time Click the up- or down arrow respectively to 
increase or decrease the value, or enter the desired value in the field directly. 

8 Enter the Door held open warning time – if a door monitor contacts exists 
and the function is selected in the Installer program.  

9 Choose Security level for the door. Click the down arrow to display a list of 
available security levels. 

Note! In Reservation only security levels Card or Card+PIN be used. 
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10 Mark if Keypad back lighting, Exit request, Buzzer and Allow remote 
control from PC should be valid. 

11 Click OK 

12 Repeat step 5 - 9 for every door/cardreader in the Reservation system. 

Reservation object 
Next step is to programme the Reservation object itself. Use the chart Reservation 
objects. 

1 Click the Reservation objects tab. 

2 Click New. 

3 Enter the name of the object in the field Name. 

4 Select the Time schedules from the list. Click on the arrow to list available 
time schedules. 

5 Enter the earlier specified parameters for Max reservations per Member 
group, Max concurrent reservations and Forward reservation time. Click 
the up- or down arrow respectively to increase or decrease the value, or enter 
the desired value in the field directly. 

6 Set-up the times for Automatic Cancel time and Overlap time. 

7 Mark in the left window Available Doors box the desired doors/readers to be 
included in this reservation object. All doors involved in the total Reservation 
system are listed. (See Doors above). 

In the right window Selected the doors (for this object) will be seen. 
Authorised persons can then access these doors – when using the reserved 
object. 

8 Select in the field Main reader for the reservation object the door/reader 
aimed for reservation. 

9 Click OK. 

10 Repeat step 5 - 9 for each reservation object. 
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Decide on reservation authorities for access groups 
Use the chart Access Groups to programme which groups to be able to reserve 
different objects.  

Proceed as follows: 

1 Start the Entro program. 

2 Click on the tab Access groups 

3 Create or select an access group and go to the tab Reservation objects.  

If you also select the tick box Caretaker this group will be able to access (and 
use) this object 24 hours a day – without any reservation. (Normally you create 
a separate access group with this possibility). 

4 Select one or more of the available objects to be accessible for this group. 

5 Click OK. 

Give persons reservation authorities 
You have earlier filled in the chart Persons with information for Bewapass/Entro. In 
a reservation system it is important that every person have a Member group no 
even if it is the same for all persons. Otherwise the person cannot use reserve any 
times. 

At the same time every person belongs to one  - or more access groups. These 
may already been given possibilities to reserve. 

If not you first create a new access group and proceed as follows: 

1 Use the chart Persons. 

2 Start the Entro program 

3 The Person tab is displayed. 

4 Mark a person and click on Edit. 

5 Check that the field Member group no is correct. 

6 Check or choose correct access group. 

7 Click OK. 

8 Repeat steps 4 – 7 for every person 

Hint! You can ease the programme of cards/persons even for the reservation 
part by using e g the duplicate function described on page 26 
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Reserve and use objects 

Prerequisite  
To be able to reserve times in the Bewapass/Entro Reservation system you need a 
standard web browser in a PC - or a card reader together with a touch screen. The 
method depends of the type of installation. 

Below are both methods described. 

Login with a web browser (User) 
You need access to a standard PC with a browser (like Microsoft Explorer or 
Netscape). In addition you need an IP-address (Internet) tied to a website (running 
in one of the Entro segment controllers). 

1 Start your browser and enter the IP-address to the website. 

2 You will see a login page for the reservation.  

3 Enter your card number and your personal code (PIN). 

4 Select object and reserve times. 

5 Confirm your choices. (You can of course edit your choices). 

6 Log out. 

7 You can now wait for the reserved time and use your card in the reader at the 
reserved objects (e g the tennis court). 

Login at touch screen (User) 
In this case usually a touch screen is installed nearby the object. Together with this 
there is a cardreader used for identification. 

1 You will see Home page for the Reservation system 

2 Use your card in the cardreader. 

3 Select (by touching) the objects and times you want to reserve. 

4 Confirm your choices. (You can of course edit your choices). 

5 Log out. 

You can now wait for the reserved time and use your card in the reader at the 
reserved objects (e g the tennis court).



 

  

 

 

  

Information about the  
access control system  

 

We are now installing an access control system, which will be in use from: 

 

 
The purpose of this measure is to protect our premises against unauthorised persons. At the 
same time, we get all the advantages of a simple and flexible access control system. Each 
employee will be given a group code and/or an access card. Another alternative is an access 
card and a personal code (PIN). Do not reveal the group code or the PIN code to unauthorised 
persons. 

During the following days and hours the following security levels apply: 

Doors Days: ____to____  
from ____to____ 
this security level 
applies: 

Days:  ____to____  
from  ____to____ 
this security level 
applies:  

Days:  ____to____  
from  ____to____ 
this security level 
applies: 

    

    

    

    

    

    

    

    

    

 

The group code is:  

 

This is how to set/change your PIN code (only if allowed by the system): 
1 Press the A button on the door terminal.  

2 Use your access card in the card reader. The yellow LED is lit.  

3 Enter the old code. If you have no previous code, enter 0000.  
The yellow LED blinks twice.  

4 Enter a new code (four digits). The yellow LED blinks twice. 

Note! The code 0000 cannot be used. 

5 Enter the new code once again.
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Technical information 
Bewapass/Entro software 

• Software for control of up to 1000 systems, each capable of managing 
– 512 doors 
– 12 000 people 
– 160 time schedules 
– 240 access groups 
– 128 zones (alarm, antipassback, roll call and entrance limitation zones) 
– 10 system users in 3 levels + installer level 
– 14 holidays, 7 half days and 4 holiday periods in each time schedule 

• Supplied on CD with accompanying manuals 

Reservation Software 
• 64 reservation objects. 
• 32 time schedules with 24 intervals in each. 
• Maximum number of reservations is 1000. 
• Up to four users can be logged on simultaneously (per SR32i). 
• Member group booking is possible (every person belongs to a member group) 
• Overlap times up to 99 minutes (after booked time). 
• Automatic cancel time up to 60 minutes (allows for delay). 
• Reservation through Internet or via touch-screen. 
• MS Internet Explorer 5.0 or Netscape 4.7 (or above) is recommended as Web 

browser.  

SR32i Segment controller 
• Segment controller for 2, 4, 8, 16 or 32 doors 
• Four built-in communication interfaces:  

– RS232 – for connection of PC, printer or modem. Max 25 m 
– RS485 global – for interconnection of up to 16 segment controllers 
– TCP/IP network connection 10 Mbit for communication via WAN/LAN 
– RS485 local – for connection of up to 16 door readers 

• Input for power supply monitoring 
• Output for common SR32i alarm  
• Lockable housing for wall mounting 
• For installation inside in a dry environment only 
• Temperature range: 0° to +50°C 
• Housing fitted with tamper switch 
• Dimensions: 140 x 200 x 60 mm (HxWxD) 
• Power supply: 8–40V DC or 8–30V AC 
• Power consumption: 250 mA 
• Built-in memory for storage of the last 1200 events when PC is off line 
• RS232 interface: 

− 9600 baud 
− No parity 
− 8 bits 
− 1 start bit 
− 1 stop bit 
− Printer output with hardware handshaking (character table ISO 8859-1) 
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Basic requirements for PC: 
• Pentium processor 266 MHz 
• 64 Mb RAM 
• At least 20 MB free hard disk space 
• CD-ROM drive 
• VGA colour monitor 
• Serial port for connection of segment controller/modem 
• Local Area Network connection 
• Windows 98/2000/XP or Windows NT version 4.0 or later 

Basic requirements for network: 
• Twisted pair Ethernet 10 Mbit (10Base-T connection). 
• Communication between SR32i is done through TCP/IP, alternatively UDP. 
• Static/permanent IP-address for every SR32i (In some cases also Netmask and 

Gateway is needed). 
• Access to a SNTP Time Server for every SR32i using TCP/IP.  
• Permanent, active Internet connection of SR32i (when Internet is used). 
• DNS is not used. 
Note - when Internet connection is used, the following ports have to be open (in fire-
walls or similar) and configured as follows: 

• 4002 if communication is used between PC and the chosen SR32i. 
• HTTP (port 80) when using reservation via Internet. 
• 4011 for TCP when several SR32i communicates through LAN. 
• SNTP (port 123) for fetching correct time, if SR32i uses TCP protocol between each 

other. 
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Half days, holidays and holiday periods 
Half days 
Date Time zone 1 Time zone 2 
 From          To From        To From          To From          To From          To From          To

Holidays 
Name Date 
  

  
  
  
  
  
  
  
  
  
  
  
  
  

Holiday periods 
Start date End date 
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Reservation Time Schedule 

Name:  

Interval Day of week 

Start Stop Monday Tuesday Wednesday Thursday Friday Saturday Sunday 

         
         

         

         

         

         

         

         

         

         

         

         

         

         

         

         

         

         

         

         

         

 



 

 

Public Holidays and Holidays - Reservation 
Public Holidays   Use Global Public Holidays table (specified in the Entro program) 
Date Name 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Holidays  Use Global Holidays table (specified in the Entro program) 
Starting date Ending date 
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Persons 

Name: Card no and 
PIN- 

Access groups Member 
group 

Access 
from 

Access 
to 

Card no   

PIN 
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